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Introduction 
 
At the end of Workshop #2 (and after their follow-up homework), participants have a solid list of 
the Actions needed to better employ their natural infrastructure for flood and drought mitigation 
in the community. However, the municipality does NOT have an endless supply of people and 
dollars to get everything done. 
 
The WWN Prioritization Tool assists the municipality in identifying where to start.  
 
Overview of the Prioritization Tool 
 
Prioritization of the identified Actions takes place after Workshop #2. The process is facilitated by 
the Team Leader, and uses participants’ informed opinions and a spreadsheet computation to 
rank order the catalogued WWN Actions. There are at least three steps, with an optional fourth. 
 
1. Confirm the criteria – the WWN Prioritization Tool uses seven Effectiveness criteria and seven 
Feasibility criteria. If desired, the Team Leader can change these and/or engage participants in 
doing so. 
 
2. Weight the criteria (optional) – having each criterion count the same is perfectly valid, but the 
Team Leader may decide to weight them differently; the WWN Criteria Weighting Tool will 
facilitate this. 
 
3. Assess the priority of each Action – the Team Leader pre-fills the Actions and any criteria 
weighting to the WWN Prioritization Tool workbook, and sends a copy to each participant to fill 
out and return. 
 
4. Collate the Priority scores – after receiving all workbooks back, the Team Leader collates the 
results, and transfers the final rank-order scores into the WWN Workbook’s ‘Actions’ tab. 
 
The WWN Workbook is then complete, and ready to form the basis of the subsequent Policy 
Development Meeting. 
 

A Note About ‘Importance’ 
 
It is critical to note that the ranking is not from “unimportant” to “important” – by definition each 
of these Actions has been deemed important by the team. It would be a mistake to believe that 
undertaking the first few of Actions constitutes a sufficient or even strategic approach. The WWN 
Prioritization Tool simply helps municipalities know where to start, and where they are going to 
get their biggest bang for their buck as they begin this journey. 
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Instructions for the WWN Prioritization Tool 
 
A copy of the WWN Prioritization Tool is sent by the Team Leader to all participants after 
Workshop #2. 
 
The Prioritization Tool is contained within an MSExcel spreadsheet. The Team Leader must 
prepare the spreadsheet in advance to include: 

1. All the Actions catalogued by the Team, and 
2. The Criteria Weightings (if that option has been used) 

 
Participants use their copy of the spreadsheet to record their assessment scores. Each sheet or 
‘tab’ within the document contributes a different piece to the prioritization process, and the 
participants simply need to follow them in order to complete this step. (NB: The following 
instructions are also contained within the spreadsheet under the ‘Start Here’ tab) 
 
All tabs use the following conventions: 

• Yellow highlighting indicates directions for using that tab 
• Green highlighting means you can enter information in those cells (and only those cells!) 
• No highlighting means the cell contains headers or calculates automatically,  

 
Actions 
 
This is where a participant sees all the Actions they need to prioritize. The Team Leader will have 
copy-and-pasted them directly from the Actions tab in the main Working With Nature workbook. 
 
Action Assessment 
 
This is where participants enter their personal assessment of each Action. 
 
The Assessment is divided into two categories: Effectiveness and Feasibility. ‘Effectiveness’ criteria 
help them score the ability of a given Action to contribute to the agreed-upon goals; ‘Feasibility’ 
criteria help them score that Action in terms of how feasible it is for your municipality. 
 
For each, participants enter a number between 1 and 10, where 10 represents the highest 
contribution or capability.   
 
You can change the Criteria, but they need to be the same criteria used by all participants in the 
prioritization process are using. There is a maximum of seven criteria for each of Effectiveness 
and Feasibility.  
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Criteria Weighting 
 
This is where you enter the relative weightings that will be applied to each Criterion.  
 
If you used it, these numbers will come from the WWN Criteria Weighting Tool, and will be the 
same for every participant, based on a consensus process, such as that used in the WWN Criteria 
Weighting Tool.  
 
If you do not plan to weight the criteria, change all weightings to 1.0. 
 
Weighted Scores 
 
There is no action required by you here, as this calculates automatically.  
 
This simply shows the resulting weighted scores for each Action by Criterion. The numbers have 
no stand-alone value (they are not a percentage or a rank), and are simply used to calculate the 
relative priority of various Actions. 
 
Summary 
 
This is where the relative scores are displayed; no data entry is required here. 
 
The resulting table shows the Actions with a score for each of ‘Effectiveness’ and ‘Feasibility’, and 
then a combined score. Again, the scores have no stand-alone information, but allow you to see 
the relative priority of each Action. 
 
The last column – Summary Score – must be collected from every Participant to be pasted into 
the Action Score Averaging Tool. 
 
CAUTION: Make sure your Actions are in the same order for each Participant, and that the order 
matches the list of Actions in the Action Score Averaging Tool, before pasting. 
 
This Summary Table is calculated and should not be edited. However, you can refresh it, re-sort 
it, or copy it using the following instructions: 
 
Refresh: The Table needs to be refreshed to show the results of the information you have 
provided. Right-click (Alternate-click) anywhere in the table, and choose 'Refresh' from the drop-
down list. 
 
Sort: To Sort the results, click on the down arrow in the 'Row Labels' cell. Choose the type of 
score you want to sort by (Effectiveness, Feasibility, or Summary), and select 'Descending' to 
make the list go from highest to lowest 
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Copy and Paste: To copy-and-paste, select the cells you want to copy, and click 'Copy'. When you 
Paste into another spreadsheet or document it will insert just the values, in the order they are 
currently sorted. 
 

Instructions for the WWN Criteria Weighting Tool 
 
The WWN Criteria Weighting Tool works in concert with the Prioritization Tool – the Prioritization 
Tool requires weighted criteria, and this is where that happens. 
 
The Prioritization Tool lets participants collective prioritize the Actions they have come up with. 
That prioritization happens by assessing each Action against a series of criteria. However, not all 
criteria are equally important. This tool allows you to give different criteria different ‘weights.’  
 
Team Leader vs Participant Spreadsheet 
 
There are two versions of the Criteria Weighting Tool spreadsheet: 

• C_Criteria Weighting – Participant – For Participants where they can enter their desired 
weightings, 

• C_Criteria Weighting – Team Leader – For the Team Leader where s/he can collate all 
participant responses and create one set of weightings. 

 
Confirming the Criteria 
 
This is where you confirm that these are, in fact, the criteria you want to use.  
 
Suggested criteria are pre-loaded into the WWN Prioritization Tool, but they can be changed. 
 
Circulate the initial criteria to all participants, and confirm that these are the ones they wish to 
use. You can make any changes, but you can have no more than 7 Effectiveness Criteria and 7 
Feasibility Criteria. 
 
Once you have confirmed the criteria, make any relevant changes to the list in both the C_Criteria 
Weighting – Participant and the C_Criteria Weighting – Team Leader workbooks, ‘Action Assessment’ 
tab in the WWN Prioritization Tool. 
 
Weighting the Criteria as Individuals 
 
The “C_Criteria Weighting – Participant” is where each participant gets to provide their view of how 
the different criteria should be weighted.  
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Send the spreadsheet to each person who is participating (there can be a maximum of 20 
participants). Have each person use the tab to weight each criterion on a scale of 1-10 (10 being 
the highest importance) in terms of how much this factor should influence decision making. 
 
Combining the Weightings 
 
This is where you combine the weightings provided by each participant into one aggregated set. 
 
After receiving back all the ‘Individual’ weightings from each participant, enter their responses 
into the columns on the ‘Collective’ tab, with one column per participant. 
 
The ‘Weighting Factor’ is calculated automatically. Transfer these ‘Weighting Factors’ into the 
‘Criteria Weightings’ tab in the WWN Prioritization Tool. 
 

Instructions for the WWN Action Score Averaging Tool  
 
Now that you have all of the Prioritization Scores from all participants, it is an easy step to create 
one ‘average’ score for each Action you have identified using the WWN Action Score Averaging Tool. 
 
Entering the Actions 
 
The Team Leader copies over the list of Actions that the Team has developed, and pastes them 
on the ‘ScoreAverage’ tab. Again, remember they must be pasted in the same order as they have 
appeared in the other tools. 
 
Entering Participant Action Scores 
 
After receiving Prioritization Tools from all participants, the Team Leader enters their 
assessment scores on the ‘ScoreAverage’ tab; one column for each participant ((NB: Remember, 
there is a maximum of 20 participants). 
 
The ‘Average Score’ column automatically calculates the average score for each of the Actions. 
 
Outputting the Scores 
 
Because the scored Action list may be used in a variety of ways by each municipality, there is no 
standardized Output mechanism. However, it is easy to do. You may want to choose one of the 
following four options: 
 
1. Copy to the WWN Workbook – The priority rankings for your Actions are now in a different place 
than the details about the Actions. The ‘Actions’ tab in the WWN Workbook includes a column for 
including the Priority of each Action. To copy the rankings from the Prioritization Tool: 
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a) Make sure your list of Actions in the WWN Workbook is in the same order as the list of 

Actions in the Prioritization Tool 
b) On the ‘Summary’ tab of the Prioritization Tool, highlight and copy the numbers in the 

‘Summary Scores’ column 
c) On the ‘Actions’ tab of the WWN Workbook, highlight the cells in the ‘Priority’ Column (don’t 

highlight the column headings) 
d) Under the ‘Edit’ menu, choose ‘Paste Special ..’ and select the ‘Values’ radio button (to 

ensure it is the numbers and not the formulas that are pasted); click ‘OK’ 
 
2. Print – You can simply print directly from MSExcel. Select the ‘Actions’ and ‘Average Score’ 
columns, and choose ‘Print’ from the ‘File’ menu. Make sure to check that you want to ‘Print 
Selection.’ 
 
3. Copy – Again, highlight the two columns (or any portion of the worksheet), and choose ‘Copy’ 
under the ‘Edit’ menu. When pasting to another spreadsheet, be sure to use ‘Paste Special ..’ and 
select the ‘Values’ option, or you will end up just pasting the underlying formulas. 
 
4. Copy the Tab to Another Workbook – If you want to copy the tab to another MSExcel workbook, 
right-click on the tab, then choose ‘Move or Copy’. Select the existing or new workbook to which 
you want to copy the tab. Be sure to click the ‘Make a Copy’ option or it will just move the tab. 
And remember again that this will take the formulas, tied back to the original spreadsheet. To 
change that in the destination workbook, select all the text, choose Copy, then choose ‘Paste 
Special ..’ selecting the ‘Values’ option. 
 
 
 


